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Revision History 
The chart below shows the information added or revised in each release of this 

document after its initial release in May, 2015. 

RELEASE DATE ADDITION/AREVISION MADE 

06/12/2015 Added note about not covering all reports 

Added Appendix E. Locating Mainframe Reports Formerly Download… 

Added Legacy Report Number Reference 

Revised Print/Email sections for all Cognos reports 

Added Weekly Inventory Transaction Information section 

06/18/2015 Added Special County Invoice Report Information 

Added note about running multiple reports at one time 

07/14/2015 Changed intro to steps to be in logical order 

Added Weekly County IRP Transmittal section 

08/28/2015 Revised the Date prompt for Daily Funds Remittance Report to Business day 
before yesterday 

Added Short Week Info in Weekly Funds Remittance Report and in Quick 
Path 

09/28/2015 Added NMVTIS Report Email information  

Added note about how to add Cognos users 

10/12/2015 Changed “last Monday” to “Monday of previous week” for Weekly Funds 
Remittance Report (Monday Reg) on page 37 and page 114; and Weekly 
Funds Summary Report on page 41 and page 114. 

Removed step “For Select Fee Source, click CUSTOMER” and replaced with 
a note not to select anything for Week to Dates Fees prompts on page 57 and 
page 115 

10/31/2015 Replaced the Fee Collection and Distribution Report page screen shot on 
page 79 with the revised screen shot containing the new Funds Category 
prompt and added the step for the new prompt. Added the Funds Category 
prompt to the Quick Path on page 117 

12/10/2015 Corrected the number of the Production Report to 9482 in several places 

01/28/2015 In the Weekly Funds Remittance report (aka Monday Reg), on the Prompts 
page, corrected the instruction in Step 3a Select Funds Type from selecting 
“Registration” to “do not select any option” on page 37, 41, and114. 

02/16/2016 Revised instructions and added new Sample report for the NMVTIS Inquiry 
Report on page 28 and 113 
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About this Guide 

This guide provides instructions to enable you to manually run reports you may need for 

the RTS POS transactions that were formerly downloaded and printed to your printer 

automatically on a daily, weekly, and monthly basis (referred to as legacy reports). 

Information about other commonly run legacy reports (Apprehension, CRBF, and $5 

Buyer Tag Fees) that may be run on-demand are also included in this guide.  

You must be assigned the appropriate permissions to run reports, including Cognos 

Enterprise Reports. Your county RTS Admin assigns this to you on the Reports page in 

the Local Options >Security event. For more information, refer to the Adding Cognos 

Users job aid available from the Job Aids tab on the RTS Resources page on the TAC 

Hub (http://www.txdmv.gov/rts-refactoring-resources or click the  RTS Refactoring 

Resources Help icon on your desktop) 

Note: If you do not know who in your county is an RTS Admin, contact the service/help desk for 

assistance. 

Instead of printing unnecessary reports, you can now determine the report information 

you need and then run only the reports you need when you need them. Many former 

RTS reports have been consolidated and defined as Cognos reports with configurable 

options for greater flexibility. 

Although you will manually run most of the daily, weekly, and monthly reports in 

Cognos, there are some that remain in the refactored RTS POS directly.  

To help you determine which reports to run, the sections in this guide are titled with the 

information formerly gathered in the legacy reports (for example, Daily Title Funds 

Summary and Transactions Information). Each section identifies the former RTS report 

number and contains the steps for locating the report and running it. Where possible, a 

sample report is also included to provide an illustration of what you can expect. 

Once you are comfortable running the reports, you can use the sections in the Appendix 

that provide quick paths for running the reports without explanations. 

Note: This guide covers the set of standard reports, but may not cover all reports that 

your office runs on a daily, monthly, weekly, or ad-hoc basis. Although the instructions 

contain the appropriate prompts for running these reports on a specific basis, you can 

run or reprint the reports on-demand using other prompt information at whatever interval 

you need. 

http://www.txdmv.gov/rts-refactoring-resources
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Legacy Report Number Reference 
The following provides a reference to the appropriate Cognos information from a legacy 

report number perspective. 

FORMER REPORT PG # 

3461/3463 $5 Buyer Tag Fees 106 

3564 Special Plates County Invoice 17 

3664 NMVITIS Inquiry Error  23 

4552 Week-to-Date Cash Drawer  55 

456B2, 456B3, 456C4 Week-to-Date Fees 55 

458B2 Month-to-Date Fees (Consolidated Collections) 84 

458B3 Month-to-Date Fees (Fee Source) 84 

4602 Funds Transactions (Monday Reg/IRP)  46 

4602 Funds Transactions (Title) 12 

4603 Funds Summary 12 

4603 Funds Summary (Monday Reg/IRP) 46 

4604 Funds Remittance (Monday Reg/IRP) 36 

4604 Funds Remittance (Title) 7 

4672 Apprehension Report 97 

4702 Inventory Transactions 62 

4802 Monthly Funds/Registration Emissions Fee 73 

4802 Monthly Funds/Sales Tax Penalty 63 

4802 Monthly Funds/Young Farmer Program 63 

4802 Sales Tax 73 

4802 Sales Tax Emission Fee 1% 73 

4802 TERP Fee 73 

4802 Texas Mobility Fund 73 

4882 Registration and Title Emissions Summary 73 

4883 Registration and Title Emissions 73 

5152 Voided Transaction 23 

5901 Countywide Batch (Payment Type, Fees, Inventory, Exceptions) 1 

5911 Title Package 2 

5921 Substation Batch 4 

7472 County IRP Transmittal Invoice 67 

9021 Completed Set Aside Transactions 1 

9353 Title and Registration Summary  78 

9482 Employee Production  91 

9901 Batch Inventory Action (BIAR) 1 

CRBF Report 101 
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Running Daily Reports 

The daily reports that you used to pull from your printer are now available to you to run 

manually as Cognos reports or from the POS Reprint Reports event. 

The reports that are manually run from the Reports > Reprint reports include reports you 

may be used to working with and reprinting from the POS: 

 9901 Batch Inventory Action (BIAR) 

 5901 Countywide Batch (Payment Type, Fees, Inventory, Exceptions) 

 5911 Title Package 

 5921 Substation Summary Batch  

 9021 Completed Set Aside Transactions 

The steps for reprinting the reports are covered in respective sections. For the reports 

that were converted to Cognos reports, the steps for manually running the reports, 

including selecting the report and supplying values on the Prompts page that displays, 

are described in detail. Samples of the reports are provided at the end of each report 

section to help you work with the new reports. 

Many of the names of the Cognos match up to the name of the former mainframe report 

(like the Funds Remittance Report and the Voided Transaction reports). However, some 

reports, like similarly named summary and detail reports, have been combined into one 

report that contains a summary section at the top and sets of details in their own tables.  

The Cognos reports you can manually run daily if you need this information include: 

 Funds Remittance Report to gather the information in the former 4604 Funds 

Remittance (Title) report. 

 Fee Types Funds Report to gather the information in the former 4602 Funds 

Transactions (Title) and 4603 Funds Summary reports. Note that the former 

Transactions and Summary information is combined into one Fee Types Funds 

Report for convenience with a summary section at the top and sets of details in 

their own tables. 

 Special County Invoice Report to gather the information in the former 3564 

Special Plates County Invoice. 

 Voided Transactions Report to gather the information in the former 5152 

Voided Transaction report. 

 NMVITIS Inquiry Report to gather the information in the former 3664 NMVITIS 

Inquiry Error report. 
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Daily BIAR, Countywide, Title Package, and Completed Set 
Aside Transaction Reports 

The main TAC office can manually run the following daily reports from the POS using 

the Reports > Reprint Reports event. 

 9901 Batch Inventory Action (BIAR) 

 5901 Countywide Batch (Payment Type, Fees, Inventory, Exceptions) 

 5911 Title Package 

 9021 Completed Set Aside Transactions 

Note: Each TAC substation can manually run daily reports for their office. Refer to Daily 

Substation Reports on page 4. 

By default, the reports will print directly to your default printer; however, you can select 

(on the Reprint Reports page) to have the reports display onscreen and then send them 

to your printer.  

1. After logging into the RTS POS, click Reports from the main page access bar and 

then click Reprint Reports. 
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2. On the Reprint Reports RPR002 page: 

 

3. In the list of reports displayed (on the Batch category page), select Batch Inventory 

Action. 

4. Press and hold the Shift key on your keyboard as you select the Completed Set 

Aside Transaction, Countywide Batch and Title Package reports. 

5. To display the reports onscreen before they print, click the Display report(s) before 

printing checkbox. 

6. Click the Enter button. 

7. If the reports will display onscreen: 

a. Verify the information and click the Print button. 

b. On the Print RPR008 page, click the Enter button. 

c. Repeat steps a and b for each report displayed. 
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Daily Substation Reports 

The substations of the main TAC office can manually run the following daily reports from 

the POS using the Reports > Reprint Reports event: 

 9901 BIAR Report  

 5911 Title Package 

 5921 Substation Summary Batch (which contains the 5922 Substation Fees and 

5923 Substation Inventory) 

 9021 Completed Set Aside Transactions 

By default, the reports will print directly to your default printer; however, you can select 

(on the Reprint Reports page) to have the reports display onscreen and then send them 

to your printer. 

1. After logging into the RTS POS, click Reports from the main page access bar and 

then click Reprint Reports. 
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2. On the Reprint Reports RPR002 page: 

 

3. From the list of reports displayed (on the Batch category page), select Batch 

Inventory Action. 

4. Press and hold the Shift key on your keyboard as you select the Completed Set 

Aside Transaction, Countywide Batch and Title Package reports. 

5. To display the reports onscreen before they print, click the Display report(s) before 

printing checkbox. 

6. Click the Enter button. 

7. If the reports will display onscreen: 

a. Verify the information in the BIAR and click the Print button. 

b. On the Print RPR008 page, click the Enter button. 

c. Repeat steps a and b for the Title Package report. 



 

Running Daily Reports 02/16/16  6  

8. Back on the Reprint Reports RPR002 page, click the Funds option (in the Select a 

Report Category area). 

9. Locate and select Substation Summary Online. 

10. To display the report onscreen before it prints, click the Display report(s) before 

printing checkbox. 

11. Click the Enter button. 

12. If the report will display onscreen: 

a. Verify the information and click the Print button. 

b. On the Print RPR008 page, click the Enter button. 
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Daily Funds Remittance Title Information 

The information gathered in the former 4604 Funds Remittance (Title) report is now 

available in the Funds Remittance Report in Cognos.  

1. After logging into Cognos and displaying the Public Folders area on the Cognos 

Connection home page, click the  Finance folder. 

 

2. In the Finance reports list displayed, locate and click  Funds Remittance 

Report. 

Note: To open this report and run it in its own tab (so you can run multiple reports at one 

time), right-click the report, click Open in new tab, and then click the tab open. 
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3. On the Prompts page: 

 

a. For Select Start Date, click the  and select the date representing the 

business day before yesterday. 

b. For Select End Date, click the  and select the date representing the business 

day before yesterday. 

c. For Select Office, click the drop-down list and click your office. 

d. For Select Funds Type, click TITLE. 

e. Click the Finish button. 

4. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Finance reports list. 
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Sample Report 

The Daily Funds Remittance Report (Title) provides the space for the signature, date, 

and check or electronic fund transfer information for the remittance. 
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Daily Funds Summary and Transaction Information 

The information gathered in the former 4602 Funds Transactions (Title) and 4603 Funds 

Summary reports is now available in the Fee Types Funds report in Cognos. 

Note: For the Monday Reg/IRP information, refer to Weekly Funds Transactions and Summary 

(Monday Reg/IRP) Information on page 46. 

1. In the  Finance folder reports list, click  Fee Type Funds Report. 

Notes:  

(1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders 

area or click the Public Folder tab on the Cognos page currently displayed, and then click 

the Finance folder. 

(2) To open this report and run it in its own tab (so you can run multiple reports at one time), 

right-click the report, click Open in new tab, and then click the tab open 
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2. On the Prompts page: 

 

a. For Select Start Date, click the  and click the date for yesterday. 

b. For Select End Date, click the  and click date for yesterday. 

c. For Select Office, click the drop-down list and click your office. 

d. For Select Fee Type, click the drop-down list and click Title. 

e. Click the Finish button. 

3. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Finance reports list. 
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Sample Report 

The Daily Fee Type Funds Report contains a summary of the fees collected during title 

transactions as well as the displays the transactions involved for each fee. 
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Daily County Special Plates Invoice Information 

The information gathered in the former 3564 Special Plates County Invoice report is 

now available in the County Special Plates Invoice Report in Cognos. 

1. On the Finance reports list, click the Public Folders tab on the Cognos Connection 

home page. 

Note: If you are not on the Finance reports list, log in to Cognos to display the Public Folder 

area or click the Public Folder tab on the Cognos page currently displayed. 

2. In the Public Folders area, click the  Registration folder. 

 

3. In the Registration reports list displayed, click the  Special Plate Registration 

folder. 

 

4. In this reports list, locate and click  County Special Plates Invoice Report. 

Note: To open this report and run it in its own tab (so you can run multiple reports at one 

time), right-click the report, click Open in new tab, and then click the tab open. 
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5. On the Prompts page: 

 

a. For Select Start Date, click the  and select the date for yesterday. 

b. For Select End Date, click the  and select the date for yesterday. 

c. For Select Office, click your office. 

d. Click the Finish button. 

6. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Special Plate 

Registration reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Special Plates 

Registration reports list. 
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Sample Report 

The County Special Plates Invoice Report may span several pages to show all of the 

special plates purchased during the day specified. The last page of the report shows the 

total number of special plates in the report. 
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Running Daily Reports 02/16/16  23  

Daily Voided Transaction Information 

The information gathered in the former 5152 Voided Transaction report is now available 

in the Voided Transaction Report in Cognos.  

1. On the Title reports list displayed, click the Public Folder tab area on the Cognos 

Connection home page. 

Note: If you are not on the Title reports list, log in to Cognos to display the Public Folder tab 

area or click the Public Folder tab on the Cognos page currently displayed. 

2. From the list of folders displayed, click the  Administrative folder. 

 

3. In the reports list displayed, locate and click the  Voided Transactions Report. 

Note: To open this report and run it in its own tab (so you can run multiple reports at one 

time), right-click the report, click Open in new tab, and then click the tab open. 
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4. On the Prompts page: 

 

a. For Transaction Start Date, click the  and select the date for yesterday. 

b. For Transaction End Date, click the  and select the date for yesterday. 

c. For Office Type, click COUNTY. 

d. Click the Refresh Office button. 

e. For Office, click your office. 

f. Click the Finish button. 

5. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Administrative 

reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Administrative 

reports list. 
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Sample Report 

The Voided Transaction report may span multiple pages. The information shows the 

transaction IDs and the name of the user who logged into the workstation where the 

voided transaction occurred. 
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Daily NMVITIS Information 

The information gathered in the former 3664 NMVITIS Inquiry Error report is now 

available in the NMVITIS Inquiry Report in Cognos. 

Note: This report is generated in Excel Worksheet format. 

Unlike other Cognos reports, you must determine if you want to email the report from 

Cognos while it is being generated. Refer to the appropriate section: 

 Running the NMVITIS Report to Completion and Printing It 

 Running the NMVITIS Report and Emailing It Before It Completes (page 31) 

Running the NMVITIS Report to Completion and Printing It 

1. On the Special Plate Registration reports list displayed, click the Public Folders 

tab on the Cognos Connection home page. 

Note: If you are not on the Special Plate Registration reports list, log in to Cognos to 

display this tab area or click the Public Folder tab on the Cognos page currently displayed. 

2. From the list of folders displayed, click the  Title folder. 

 

3. In the Title reports list displayed, locate and click  NMVITIS Inquiry Report. 

Note: To open this report and run it in its own tab (so you can run multiple reports at one 

time), right-click the report, click Open in new tab, and then click the tab open. 
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4. On the Prompts page: 

 

a. For Select Start Date, click the  and select the date for yesterday. 

b. For Select End Date, click the  and select the date for yesterday. 

c. For Select Type, leave Error selected. 

d. For Select Salvage Indicator, leave Non-Salvage selected. 

e. For Select Office, click the drop-down list and click your office. 

f. Click the Finish button. 

g. If you are running this report: 

 In a series of reports - each in their own windows, click the Public Folders 

tab to return to the reports list to run the next report and then follow the 

instructions to print it in Appendix E on page 120. 
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 To completion: 

 

1) When the Open/Save popup displays along the bottom of the page, click 

the Open button. 

2) At the top of the report page, click File > Print. 

3) On the Print page: 

 

a. From the Printer drop-down, select either the: 

 Default RTS Printer tray (To avoid using up the “500” paper 

inventory, load plain paper in this tray.) 

 RTS-Tray-1 to use the manual tray and load plain paper into the 

tray. 
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b. From the Portrait Orientation drop-down, select Landscape 

Orientation. 

c. From the No Scaling drop-down, select Fit All Columns on One 

Page. 

d. Click the Print button and then close the Excel report to return to the 

Title folder reports list. 

Running the NMVITIS Report and Emailing It Before It Completes 

1. On the Special Plate Registration reports list displayed, click the Public Folders 

tab on the Cognos Connection home page. 

Note: If you are not on the Special Plate Registration reports list, log in to Cognos to 

display this tab area or click the Public Folder tab on the Cognos page currently displayed. 

2. From the list of folders displayed, click the  Title folder. 

 

3. In the Title reports list displayed, locate and click  NMVITIS Inquiry Report. 

Note: To open this report and run it in its own tab (so you can run multiple reports at one 

time), right-click the report, click Open in new tab, and then click the tab open. 
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4. On the Prompts page: 

 

a. For Select Start Date, click the  and select the date for yesterday. 

b. For Select End Date, click the  and select the date for yesterday. 

c. For Select Type, leave Error selected. 

d. For Select Salvage Indicator, leave Non-Salvage selected. 

e. For Select Office, click the drop-down list and click your office. 

f. Click the Finish button. 

5. On the Report is running pop-up, click Select a delivery method. 
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6. From the options displayed, click Email Report. 

 

7. On the Set the email options page, supply the necessary information.  

 

8. Click the OK button to close this page and return to the Title reports list. 
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Sample Report 

The NMVITIS Inquiry Report is formatted as an Excel spreadsheet file by default. When 

it displays onscreen, it is typically more than several screens long – although it may 

print off in several pages. 

On 02/16/2016, several columns are automatically suppressed when county end users 

run the report (such as the Office, Regional Office, Type, and Salvage Indicator) and 

word wrapping within each column is enabled. The report looks similar to the following. 
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Running Weekly Reports 

The weekly reports that you used to pull from your printer are now available to you to 

run manually as Cognos reports. The following sections include the steps for manually 

running the reports, including selecting the report and supplying values on the Prompts 

page that displays. Samples of the reports are provided at the end of each report 

section to help you work with the new reports. 

Many of the names of the Cognos match up to the name of the former mainframe report 

(like the Funds Remittance Report and the Voided Transaction reports). However, some 

reports, like similarly named summary and detail reports, have been combined into one 

report that contains a summary section at the top and sets of details in their own tables.  

The Cognos reports you can manually run for weekly information if you need this 

information include: 

 Funds Remittance Report to gather the information in the former report 4604 

Funds Remittance Monday Registration and the 4604 Funds Remittance for IRP 

reports. 

Note: The procedure for running the short week Funds Remittance report is slightly 

different. To avoid extra information, you must run the report two business days after the 

month ends. Refer to page 40. 

 Fee Types Funds Report to gather the information in the former 4602 Funds 

Transactions Monday Registration/IRP and 4603 Funds Summary Monday 

Registration/IRP reports. You will run a Fee Type Funds Report for the 

Registration data and another one for IRP data). Note that the former 

Transactions and Summary information is combined into one Fee Types Funds 

Report for convenience with a summary section at the top and sets of details in 

their own tables. 

 Week/Month-To-Date Fees Report to gather the information in the former 4552 

Week-to-Date Cash Drawer and the 456B2, 456B3, and 456C4 Week-to-Date 

Fees reports. The Cash Drawer information is in a table within the report. 

 Inventory Transactions Report to gather the information in the former 4702 

Inventory Transaction report. 

Note: The County IRP Transmittal Invoice Report to replace the 7472 County IRP 

Transmittal Invoice information is not yet available in Cognos. Refer to the latest 

Release Notes for information about receiving this report. 
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Weekly Funds Remittance (Monday Reg/IRP) Information 

The information gathered in the former 4604 Funds Remittance (Monday 

Registration/IRP) report is now available in the Funds Remittance Report in Cognos. 

Note: For a short week, refer to the next section on page 40. 

1. After logging into Cognos and displaying the Public Folders area on the Cognos 

Connection home page, click the  Finance folder. 

 

2. In the Finance reports list displayed, locate and click  Funds Remittance 

Report. 

Note: To open this report and run it in its own tab (so you can run multiple reports at one 

time), right-click the report, click Open in new tab, and then click the tab open. 
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3. On the Prompts page: 

 

a. For Select Start Date, click the  and select the date for the Monday of the 

previous week (for example, if you running this report on Tuesday, September 

29, you would select Monday, September Monday 21). 

b. For Select End Date, click the  and select the date for last Sunday. 

c. For Select Office, click the drop-down list and select your office. 

d. For Select Funds Type, do not select any option. 

e. Click the Finish button. 

4. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Finance reports list. 
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Short Week Weekly Funds Remittance (Monday Reg) 

If the last week of the month is a short week, the Weekly Funds Remittance report to 

get Registration information for that week must be run on the second business day after 

the month ends to get the correct data. If the last day of a month is on: 

 Monday, run the report on the Wednesday two days later 

 Tuesday, run the report on the Thursday two days later 

 Wednesday, run the report on the Friday two days later 

 Thursday, run the report on the following Monday 

1. After logging into Cognos and displaying the Public Folders area on the Cognos 

Connection home page, click the  Finance folder. 

 

2. In the Finance reports list displayed, locate and click  Funds Remittance 

Report. 

Note: To open this report and run it in its own tab (so you can run multiple reports at one 

time), right-click the report, click Open in new tab, and then click the tab open. 
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3. On the Prompts page: 

 

a. For Select Start Date, click the  and select the date for  the Monday of the 

previous week (for example, if you running this report on Tuesday, September 

29, you would select Monday, September Monday 21). 

b. For Select End Date, click the  and select the date for this coming Sunday (or 

last Sunday if you are running this on the Monday for a short week that ended 

last Thursday). 

c. For Select Office, click the drop-down list and select your office. 

d. For Select Funds Type, do not click any option. 

e. Click the Finish button. 

4. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 
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Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 

 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 
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c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 

 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Finance reports list. 
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Sample Report 

The Funds Remittance Report may span several pages to show all of the categories in 

which the funds were collected during the week specified and contains a summary of 

the CRBF owed on the last page. 
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The final page shows a summary of the CRBF. 
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Weekly Funds Transactions and Summary (Monday Reg/IRP) 
Information 

The information gathered in the former 4602 Funds Transactions (Monday Registration / 

IRP) and 4603 Funds Summary (Monday Registration/IRP) reports is now available in 

the Fee Types Funds report in Cognos. 

1. From the Finance reports list, locate and click  Fee Type Funds Report. 

Notes: 

(1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders 

area or click the Public Folder tab on the Cognos page currently displayed, and then click 

the Finance folder. 

(2) To open this report and run it in its own tab (so you can run multiple reports at one time), 

right-click the report, click Open in new tab, and then click the tab open. 
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2. On the Prompts page: 

 

a. For Select Start Date, click the  and select the date for last Monday. 

b. For Select End Date, click the  and select the date for last Sunday. 

c. For Select Office, click the drop-down list and click your office. 

d. For Select Fee Type, click Registration. 

e. Click the Finish button. 

3. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Finance reports list. 

4. Back on the Finance reports list page, click the  Fee Type Funds Report again. 

5. On the Prompts page:  

a. For Select Start Date, click the  and select the date for last Monday. 

b. For Select End Date, click the  and select the date for last Sunday. 
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c. For Select Office, click the drop-down list and select your office. 

d. For Select Fee Type, click IRP. 

e. Click the Finish button. 

6. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 

 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 
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c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 

 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  
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d. Click the OK button to close this page and return to the Finance reports list. 
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Sample Report 

The Fee Type Funds Reports typically span multiple pages to show a summary of all 

the fees associated with registration collected on each date in the week specified and 

then sections for each fee collected that show the specific transactions involved. 

Page 1 shows the beginning of the Summary. It can be followed by multiple pages of 

the Summary. 
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After the Summary totals display, the individual details sections for each transaction 

display through the end of the report.  
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Week-To-Date Cash Drawer and Week-To-Date Fees 
Information 

The information gathered in the former 4552 Week to Date Cash Drawer and the 

456B2, 456B3, and 456C4 Week to Date Fees reports is now available in sections of 

the Week/Month-To-Date Fees Report in Cognos. 

1. In the Finance reports list displayed, locate and click the  Week/Month-To-Date 

Fees Report. 

Notes: 

(1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders 

area or click the Public Folder tab on the Cognos page currently displayed, and then click 

the Finance folder. 

(2) To open this report and run it in its own tab (so you can run multiple reports at one time), 

right-click the report, click Open in new tab, and then click the tab open. 
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2. On the Prompts page: 

 

a. For Select Report Type, be sure the Weekly option is selected. 

b. For Select Week Date, click the  and select last Sunday. 

c. For Select Office, click your office from the list displayed. 

Note: Do not select any option in the Fee Type area, which will provide the entire report. 

d. Click the Finish button. 

3. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Finance reports list. 
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Sample Report 

The Week/Month-To-Date Fees Report spans multiple pages with multiple sections in it 

(as shown in the sample report.)  

Within the report, the: 

 Total by Office section shows the fee source type and fees collected by day and 

ends with Grand Totals of this information.  

 Total by Fee Source section shows the total amount of each type of fee collected 

by the office. 

 Totals by Branch Office ($) section shows the amounts collected in each cash 

drawer. 

 Funds Adjustments section shows the name of the fee adjusted, when it was 

made, and the amount of the adjustment as well as the grand total of 

adjustments. 
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Page 1 starts with the Total by Office section, which shows the fee source type and fees 

collected by day and may span multiple pages before it ends.  

 



 

Running Weekly Reports 02/16/16  61  

After the first section grand totals, other sections of information display, including the 

cash drawer information (in the Totals by Branch Office section) and the Adjustment 

section. 
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Weekly Inventory Transaction Information 

The information gathered in the former 4702 Inventory Transaction report is now 

available in the Inventory Transaction Report in Cognos. 

1. From the Finance reports list, click the Public Folders tab.  

Notes: 

(1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders 

area or click the Public Folder tab on the Cognos page currently displayed and then click 

the Finance folder. 

(2) To open this report and run it in its own tab (so you can run multiple reports at one time), 

right-click the report 

2. Click the  Inventory folder. 

 

3. In the reports list displayed, locate and click  Inventory Transactions Report. 

Note: To open this report and run it in its own tab (so you can run multiple reports at one 

time), right-click the report, click Open in new tab, and then click the tab open. 
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4. On the Prompts page: 

 

a. For Select Start Date, click the  and select the date for last Monday. 

b. For Select End Date, click the  and select the date for last Sunday. 

c. For Select Office, select your office from the list. 

d. Click the Finish button. 

5. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Inventory reports 

list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Inventory reports list. 
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Sample Report 

The Inventory Transactions report may span several pages to show all of the types of 

inventory selected for the report. 

No sample is available at this time. 



 

Running Weekly Reports 02/16/16  67  

Weekly County IRP Transmittal Invoice Information 

The information gathered in the former weekly 7472 County IRP Transmittal Invoice 

report is now available in in Cognos as the Weekly County IRP Transmittal Invoice. 

1. From the Finance reports list, locate and click  Weekly County IRP Transmittal 

Invoice. 

Notes: 

(1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders 

area or click the Public Folder tab on the Cognos page currently displayed, and then click 

the Finance folder. 

(2) To open this report and run it in its own tab (so you can run multiple reports at one time), 

right-click the report, click Open in new tab, and then click the tab open. 

 

2. On the Prompts page: 
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a. For Select Start Date, click the  and select the date for last Monday. 

b. For Select End Date, click the  and select the date for last Sunday. 

c. For Select Office, select your office from the list. 

d. Click the Finish button. 

3. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 

 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 
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c. From the Cognos Viewer toolbar, click  to return to the Inventory reports 

list. 

 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 
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c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the reports list. 
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Sample Report 

The Inventory Transactions report may span several pages to show all of the types of 

inventory selected for the report. 

No sample is available at this time. 
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Running Monthly Reports 

The monthly reports that you used to pull from your printer are now available to you to 

run manually as Cognos reports. The following sections include the steps for manually 

running the reports, including selecting the report and supplying values on the Prompts 

page that displays. Samples of the reports are provided at the end of each report 

section to help you work with the new reports. 

Many of the names of the Cognos match up to the name of the former mainframe report 

(like the Funds Remittance Report and the Voided Transaction reports). However, some 

reports, like similarly named summary and detail reports, have been combined into one 

report that contains a summary section at the top and sets of details in their own tables.  

The Cognos reports you can manually run for monthly information if you need this 

information include: 

 Monthly Funds Report to gather the information in the former 4802 Monthly 

Funds report (such as the TERP, Registration Emission, Young Farmer, Texas 

Mobility Fund, and Sales Tax fees). You can run each type of fund individually, 

run them all, or select specific funds to run in one report. 

 Employee Transaction Report to gather the information in the former 9482 

Employee Production report.  

 Fee Collection and Distribution Report to gather the information in the former 

9353 Title and Registration Summary 

 Week/Month-To-Date Fees Report to gather the information in the former 

458B2 Month-to-Date Fees (Consolidated Collections) and 458B3 Month-to-Date 

Fees (Fee Source) reports. 
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Monthly Funds Information 

The information gathered in the former 4802 Monthly Funds report (such as the TERP, 

Registration Emission, Young Farmer, Texas Mobility Fund, and Sales Tax fees) is now 

available in the Monthly Funds Report in Cognos.  

1. From the Public Folders area, click the  Finance folder. 

Note: If you are not on the Public Folders area, log in to Cognos to display the Public 

Folders area or click the Public Folder tab on the Cognos page currently displayed and 

then click the Finance folder. 

 

2. In the Finance reports list displayed, locate and click  Monthly Funds Report. 

Note: To open this report and run it in its own tab (so you can run multiple reports at one 

time), right-click the report, click Open in new tab, and then click the tab open. 
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3. On the Prompts page: 

 

a. For Select Year, click the drop-down and select the year. 

b. For Select Month, click the drop-down and select the previous month. 

c. For Select County, click your county in the list displayed. 

d. For Select Account Item Code, do not make a selection (which causes the 

report to run with all item codes displayed). 

e. Click the Finish button. 

4. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Finance reports list. 
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Sample Report 

The Monthly Funds report spans multiple pages. The Monthly Totals section shows the 

summary while the details for each category are contained in the remaining sections.  
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Monthly Title and Registration Summary Information 

The information gathered in the former 9353 Title and Registration Summary is now 

available in the Fee Collection and Distribution Report in Cognos.  

1. In the Finance reports list displayed, locate and click  Fee Collection and 

Distribution Report. 

Notes: 

(1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders 

area or click the Public Folder tab on the Cognos page currently displayed and then click 

the Finance folder. 

(2) To open this report and run it in its own tab (so you can run multiple reports at one time), 

right-click the report, click Open in new tab, and then click the tab open. 
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2. On the Prompts page: 

 

a. For Select Start Year, click the drop-down and select this year. 

b. For Select End Year, click the drop-down and select this year. 

c. For Select Start Month, click the drop-down list and click last month. 

d. For Select Office Type, click the COUNTY option. 

e. For Select Office, click your office. 

f. For Funds Category, click the appropriate option or do not select any option to 

report on all categories. 

f.g. Click the Finish button. 

3. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Finance reports list. 
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Sample Report 

The Fee Collection and Distribution Report spans multiple pages with 3 sections: 

 Inventory Item Counts section that runs down the left of the page 

 Fees Collected section that starts on this page and continues until it is done 

 Funds Distribution section that displays as the last section (refer to page 83) 
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The Funds Distribution section follows the end of the Fees Collected section and ends 

with an Overall Total on the last page of the report. 
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Month-To-Date Fees Information 

The data contained in the former 458B2 Month-to-Date Fees (Consolidated Collections) 

and 458B3 Month-to-Date Fees (Fee Source) reports is now available in sections of the 

Week/Month-To-Date Fees Report in Cognos. 

1. In the Finance reports list displayed, locate and click  Funds Remittance 

Report. 

Notes: 

(1) If you are not on the Finance reports list, log in to Cognos to display the Public Folders 

area or click the Public Folder tab on the Cognos page currently displayed, and then click 

the Finance folder. 

(2) To open this report and run it in its own tab (so you can run multiple reports at one time), 

right-click the report, click Open in new tab, and then click the tab open. 
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2. On the Prompts page: 

 

a. For Select Report Type, click the Monthly option. 

b. For Select Year, click the drop-down list and click the year. 

c. For Select Month, click the drop-down list and click last month. 

d. For Select Office, click your office. 

e. For Select Total BreakDown Display, leave All selected. 

f. For Select Fee Source, do not make a selection (which causes the report to run 

with all fee sources displayed). 

g. For Select Account Item Code, do not make a selection (which causes the 

report to run with all item codes displayed). 

h. Click the Finish button. 

3. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 
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Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 

 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 



 

Running Monthly Reports 02/16/16  87  

 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Finance reports list. 
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Sample Report 

Very similar to the weekly version of this report (on page 60), the Month-To-Date Fees 

Report spans multiple pages and includes several sections of information: 

 Total by Office section shows the fee source type and fees collected by day and 

ends with Grand Totals of this information.  

 Total by Fee Source section shows the total amount of each type of fee collected 

by the office. 

 Totals by Branch Office ($) section shows the amount of money collected in each 

cash drawer. 

 Funds Adjustments section shows the name of the fee adjusted, when the 

adjustment was made, and its amount as well as grand total of adjustments. 
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Page 1 starts with the Total by Office section, which shows the fee source type and fees 

collected by day and may span multiple pages before it ends.  
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After the first section grand totals, other sections of information display, including the 

cash drawer information (in the Totals by Branch Office section) and the Adjustment 

section. 
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Monthly Employee Production Information 

The information gathered in the former 9482 Employee Production report is now 

available in the Employee Transaction Report in Cognos.  

1. From the Finance reports list, click the Public Folders tab. 

Note: If you are not on the Finance reports list, log in to Cognos to display the Public 

Folders  area or click the Public Folder tab on the Cognos page currently displayed, and 

then click the Finance folder. 

2. In the Public Folders area, click the  Performance Support folder. 

 

3. In the reports list displayed, locate and click  Employee Transaction Report. 

Note: To open this report and run it in its own tab (so you can run multiple reports at one 

time), right-click the report, click Open in new tab, and then click the tab open. 
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4. On the Prompts page: 

 

a. For Select Start Date, click the  and select the first business day of last 

month. 

b. For Select End Date, click the  and select the last business day of last month. 

c. For Select Office Type, click COUNTY and then click the Refresh button. 

d. For Select Transaction Type, do not make a selection (which causes the report 

to run with all transaction types displayed). 

e. For Select Office, click the office where the employees work and click the 

Refresh button below the list. 

f. For Select Employee Name, do not select anything (which selects all of the 

employees shown in the list). 

g. Click the Finish button. 

5. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 
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and have the system email it to you when the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 

 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Performance 

Support reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Performance 

Support reports list. 
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Sample Report 

This Employee Transaction Report can span multiple pages depending on the number 

of employees and the transaction types selected. Each employee is listed within a 

section and the sections may break over several pages. The total number of 

transactions and the total number of days worked are available at the end of each 

employee section. 
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Other Report Information 

The following sections explain how to locate the legacy report information in Cognos 

reports that you can run on demand when you need them: 

 Apprehension information on page 97 

 County road and bridge fund (CRBF) information on page 101 

 $5 buyer tag fee information on page 106 
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Apprehension Information 

Apprehension information (formerly run as 4672 Apprehension Report) is now gathered 

in the daily and weekly Funds Remittance report described in previous sections of this 

guide and displays as a section of information if any apprehensions occurred within the 

timeframe when the report is run. 

You can also run the Week/Month-To-Date Fees and select APPREHENSIONS as a 

Fee Source if you are looking for that information.  

To run the Week/Month to Date report: 

1. From the Public Folders area on the Cognos Connection home page, click the  

Finance folder. 

Note: If you are not on the Public Folders area, log in to Cognos to display this tab area or 

click the Public Folders tab on the Cognos page currently displayed. 

 

2. In the Finance reports list displayed, locate and click the  Week/Month-To-Date 

Fees Report. 
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3. On the Prompts page: 

 

a. For Select Report Type, click the appropriate option. 

b. For Select Date, click the  and select the appropriate dates. 

c. For Select Office, click your office from the list displayed. 

d. For Select Fee Type, click APPREHENSIONS. 

e. Click the Finish button. 

4. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Finance reports list. 
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CRBF Information 

The County Road and Bridge Fee (CRBF) information is gathered in the CRBF Report 

in Cognos in the Finance Folder. 

1. On the Public Folders area, click the  Finance folder. 

Note: If you are not on the Public Folders area, log in to Cognos to display this tab area or 

click the Public Folders tab on the Cognos page currently displayed. 

 

2. In the reports list displayed, locate and click the  CRBF Report. 
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3. On the Prompts page: 

 

a. For Select Start Date, click the  and select the appropriate date. 

b. For Select End Date, click the  and select the appropriate date. 

c. For Select County, click your office from the list displayed. 

d. Click the Finish button. 

4. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Finance reports list. 
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Sample Report 
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$5 Buyer Tag Fee Information 

The $5 Buyer Tag Fee information is gathered in the $5 Buyer Tag Fees Report in 

Cognos in the Finance Folder. You can report on information for a month. You can also 

select a specific dealer to report on. 

1. In the Public Folders area, click the  Finance folder. 

Note: If you are not on the Public Folders area, log in to Cognos to display this tab area or 

click the Public Folders tab on the Cognos page currently displayed. 

 

2. In the Finance reports list displayed, locate and click the  $5 Buyer Tag Fees 

Report. 
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3. On the Prompts page: 

 

a. For Select Start Date, click the drop-down list and select the appropriate date. 

b. For Select End Date, click the drop-down list and select the appropriate date. 

c. For Select County, click your office from the list displayed. 

d. Click the Finish button. 

4. When the Your report is running pop-up 

displays, you can wait for the report to finish 

running and print it from the onscreen 

display or run the report in the background 

and have the system email it to you when 

the report finishes running. 

Note: If you are running each report in its own window, you can click the Public Folders tab 

to return to the reports list and run the next report. And then, follow the instructions in 

Appendix E on page 120. 
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 To wait and print directly from the onscreen display: 

a. From the Adobe toolbar that displays across the top of the report, click  

(Print). 

b. On the Print pop-up, to use the: 

o Default RTS Printer tray: 

Tip: To avoid using up the “500” paper inventory, you can load some plain paper 

in this tray. 

1) From the Printer drop-down, select RTS-Tray-2. 

2) Click the Print button. 

o Manual feed tray of your RTS printer: 

1) Pull down Tray 1 and load paper into it. 

2) From the Printer drop-down, select RTS-Tray-1. 

3) Click the Print button. 

 

c. From the Cognos Viewer toolbar, click  to return to the Finance reports list. 
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 To email the report to yourself so you can send it to print later: 

a. On the pop-up, click Select a delivery method. 

 

b. From the options displayed, click Email Report. 

 

c. On the Set the email options page, supply the necessary information.  

 

d. Click the OK button to close this page and return to the Finance reports list. 
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Sample Report 
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Appendix A. Daily Reports Quick Path 

Running the Daily Cognos Reports 

1. Click  (Cognos Reports) and log in. 

2. Click  Finance. 

3. Click  Funds Remittance Report. 

4. For Prompts: 

 Select Start Date = Business day before yesterday 

 Select End Date = Same as above 

 Select Office = Your office 

 Select Funds Type= TITLE 

5. Click Finish. 

6. Click . 

7. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 

8. Click Print. 

9. Click  (to return to the last reports list) 

10. Click  Fee Type Funds Report. 

11. For Prompts: 

 Select Start Date = Yesterday 

 Select End Date = Yesterday again 

 Select Office = Your office 

 Select Fee Type = Title 

12. Click Finish. 

13. Click . 

14. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 
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15. Click Print. 

16. Click . 

17. Click  Registration. 

18. Click  Special Plates Registration. 

19. Click  County Special Plates Invoice Report. 

20. For Prompts: 

 Transaction Start Date = Yesterday 

 Transaction End Date = Yesterday 

 Office = Your office 

21. Click Finish. 

22. Click . 

23. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 

24. Click Print. 

25. Click . 

26. Click  Administrative. 

27. Click  Voided Transactions Report. 

28. For Prompts: 

 Transaction Start Date = Yesterday 

 Transaction End Date = Yesterday 

 Office Type = COUNTY (Refresh Office button). 

 Office = Your office 

29. Click Finish. 

30. Click . 

31. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 

32. Click Print. 
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33. Click . 

34. Click  Title.  

35. Click  NMVITIS Inquiry Report. 

36. For Prompts: 

 Select Start Date = Yesterday 

 Select End Date = Yesterday 

 Select Type = Error  

 Select Salvage Indicator = Non-Salvage 

 Select Office = Your office 

37. Click Finish. 

38. Click . 

39. Click RTS Tray 2 (or Tray 1 and load paper). 

40. Click Print. 

Running the Daily RTS POS Reports (Main Office) 

1. Click  and log in. 

2. Click Reports > Reprint Reports. 

3. On Reprint Reports RPR002, click Shift +: 

 Batch Inventory 

 Completed Set Aside Transactions 

 Countywide Batch 

 Title Package 

4. Click Enter. 

5. Click Funds. 

6. Click Substation Batch Summary. 

7. Click Enter. 

To fit the NMVITIS report on a 

page so it is readable, change 

Print settings: 

 Portrait Orientation >  

Landscape Orientation  

 No scaling > Fit all 

columns on One Page 

Print Note: 
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Appendix B. Weekly Reports Quick Path 

1. Click  and log in. 

2. Click  Finance. 

3. Click  Funds Remittance Report. 

4. For Prompts: 

 Select Start Date = Monday (of prev week) 

 Select End Date = Last Sunday 

 Select Office = Your office 

 Select Funds Type = no selection 

5. Click Finish. 

6. Click . 

7. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 

8. Click Print. 

9. Click . 

10. Click  Fee Type Funds Report. 

11. For Prompts: 

 Select Start Date = Monday (of previous week) 

 Select End Date = Last Sunday 

 Select Office = Your office 

 Select Fee Type =  Registration 

12. Click Finish. 

13. Click . 

14. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 

15. Click Print. 

16. Click . 

For a short week, you must run this report 

on the 2nd business day after the month 

ends using the following prompts: 

 Select Start Date = Previous Monday 

 Select End Date = Upcoming Sunday 

(or Last Sunday if running this on the 

Monday for a short week that ended last 

Thursday) 

 Select Office = Your office 

 Select Funds Type =  no selection 

For a short week: 
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17. Click  Fee Type Funds Report. 

18. For Prompts: 

 Select Start Date = Last Monday 

 Select End Date = Last Sunday 

 Select Office = Your office 

 Select Fee Type = IRP 

19. Click Finish. 

20. Click . 

21. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 

22. Click Print. 

23. Click . 

24. Click  Week/Month-To-Date Fees Report. 

25. For Prompts: 

 Select Report Type = Weekly  

 Select Week Date = Last Monday 

 Select Office = Your office 

Note: Do not make any selection for Fee Type to print entire report. 

26. Click Finish. 

27. Click . 

28. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 

29. Click Print. 

30. Click . 

31. Click  Inventory. 

32. Click  Inventory Transactions Report. 
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33. For Prompts: 

 Select Start Date = Last Monday 

 Select End Date = Last Sunday 

 Select Office = Your office 

34. Click Finish. 

35. Click . 

36. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 

37. Click Print. 

38. In the Task bar at the bottom left of your computer screen, click the File Explorer 

icon.  

39. In the address bar at the top of the File Explorer page : 

a. Click in the open space to the right of the word Libraries. 

b. On your keyboard, press the letter D and then the : (colon) key. 

c. Press the Enter key. 

40. In the list of folders displayed, locate and double-click the  RTS folder. 

41. In the list of folders displayed, locate and double-click the  DL folder. 

42. In the list of report files displayed, locate and double-click the appropriate  IRP 

report. 

43. On the Full Screen prompt, click the: 

 Yes button to use your entire screen to display the report  

 No button to display the report in a smaller window on your screen. 

44. At the top of the Adobe report page, click the File menu and click Print (or click the 

 icon. 
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Appendix C. Monthly Reports Quick Path 

1. Click  and log in. 

2. Click  Finance. 

3. Click  Monthly Funds Report. 

4. For Prompts: 

 Select Year = This year 

 Select Month= Last month 

 Select County= Your county 

5. Click Finish. 

6. Click . 

7. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 

8. Click Print. 

9. Click . 

10. Click  Fee Collection and Distribution Report. 

11. For Prompts: 

 Select Start Year = This year 

 Select End Year = This year 

 Select Start Month = Last month 

 Select Office Type = COUNTY 

 Select Office = Your office 

 Select Funds Category = Appropriate options 

12. Click Finish. 

13. Click . 

14. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 

15. Click Print. 
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16. Click . 

17. Click  Funds Remittance Report. 

18. For Prompts: 

 Select Report Type = Monthly 

 Select Year = This year 

 Select Month = Last month 

 Select Office = Your office 

 Select Total BreakDown Display = All 

19. Click Finish. 

20. Click . 

21. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 

22. Click Print. 

23. Click . 

24. Click  Performance Support. 

25. Click  Employee Transaction Report. 

26. For Prompts: 

 Select Start Date = First business day of last month 

 Select End Date = Last business day of last month 

 Select Office Type = COUNTY  

 Select Office = Your office 

27. Click Finish. 

28. Click . 

29. Click RTS Tray 2 (or Tray 1 if you have loaded paper). 

30. Click Print. 
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Appendix D. Daily Substation RTS POS Reports 
Quick Path 

1. Click  and log in. 

2. Click Reports > Reprint Reports. 

3. Click Funds. 

4. Click Ctrl +: 

 Batch Inventory 

 Title Package 

5. Click Enter. 

6. Click Funds. 

7. Click Substation Summary Online. 

8. Click Enter. 
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Appendix E. Printing Cognos Reports 

By default, most Cognos reports described in this guide are generated as PDFs for easy 

online reading and the preferred method for printing these reports is from the PDF while 

viewing online as described in the appropriate sections in this manual. (The generic 

steps are repeated below.) 

However, there may be times when you need to reduce the page count of a large report 

to save paper. To do this, you can export the processed PDF report into Excel and work 

with page and print options in Excel (such as the Page Layout or Scaling) that may help 

reduce the number of pages to print. These instructions describing how to export the 

PDF report into Excel and print the Excel file are on page 121. 

Printing a Cognos Report PDF from the Cognos Viewer 

1. From the Adobe toolbar that displays across the top of the report, click  (Print). 

2. On the Print pop-up, to 

use the:  

 Default RTS Printer 

tray: 

Tip: To avoid using 

up the “500” paper 

inventory, load plain 

paper in this tray. 

a. From the 

Printer drop-

down list, select 

RTS-Tray-2. 

b. Click the Print 

button. 

 Manual feed tray of 

your RTS printer: 

a. Pull down Tray 1 and load paper into it. 

b. From the Printer drop-down list, select RTS-Tray-1. 

c. Click the Print button. 

d. From the Cognos Viewer toolbar, click  to return to the previous reports list. 
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Exporting a Cognos Report PDF into Excel and Printing It 

1. From top toolbar in Cognos Report Viewer window of the PDF report, click 

Format ( ) > View in Excel Options > View in Excel 2007 Format.  

 

2. On the prompt displayed at the bottom of the page, click the Open button. 

 

3. If the Enable Editing button displays along the top of the Excel spreadsheet, click it 

to grant access to the file. 

 

4. On the toolbar at the top of the Excel spreadsheet, click File > Print.  
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5. On the Print page: 

a. Make sure the appropriate Printer is set. 

Tip: To avoid printing on the “500” paper inventory, add plain paper to Tray 2 of the RTS 

printer or pull down Tray 1 (the manual feed tray) and load it. 

b. Use the Settings and Custom Scaling Options to help shrink the information 

onto normal-sized print pages.  

For example, in the Settings area: 

 Click Portrait Orientation drop-down and select Landscape. 

 Click the Normal Margins drop-down and reset the margins. 

 Click Fit All Columns on One page (as shown). 

6. Click the Print button. 
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Appendix F. Locating the Mainframe Reports 
Formerly Downloaded and Printed Automatically 

 

To locate information from the former: In Cognos, go to: 

Apprehension Report (4672)  Finance > Funds Remittance Report
1
 

Funds Remittance Report (4604, 4605)  Finance > Funds Remittance Report 

Funds Summary
2
(4603) 

Funds Transactions
2
 (4602) 

 Finance > Fee Type Funds Report 

Inventory Transactions (4702)  Inventory > Inventory Transactions Report 

Monthly Funds Report  

Sales Tax Penalty (4802) 
Young Farmer (4802) 
Registration Emissions Fee (4802) 

 Finance > Monthly Funds Report 

Month-To-Date Fees Report 
(458b2/458b3) 

 Finance > Week/Month-to-Date Fees Report 

NMVTIS Inquiry Report (366a4)  Title > NMVTIS Inquiry Error Report 

Production Report (9482)  Performance Support > Employee Transaction 

Sales Tax Emission Fee 1% (4802)  Finance > Monthly Funds Report 

Sales Tax Report (4802)  Finance > Monthly Funds Report 

Special Plates County Invoice (3564)  Registration >  Special Plates Registration >  
     County Special Plates Invoice Report 

TERP Fee (4802)  Finance > Monthly Funds Report 

Texas Mobility Fund Fee (4802)  Finance > Monthly Funds Report 

Voided Transaction Report (5152)  Administrative > Voided Transactions Report 

Week-To-Date Cash Drawer (4552)  Finance > Week/Month-to-Date Fees Report 

Week-To-Date Fees Report (456b2/B3/C4)  Finance > Week/Month-to-Date Fees Report 

Weekly County IRP Transmittal invoice 
(7472) 

 Finance > Weekly County IRP Transmittal 
invoice 

Year-To-Date Reg & Title Summary (9352)  Finance > Fee Collection and Distribution Report 

To print the: In the POS, go to: 
Batch Inventory Action – BIAR (9901) Reports > Reprint Reports 

Completed Set Aside Transactions (9021) Reports > Reprint Reports 

County Wide Payment, Fees, Inventory, Exception (5902/5903/5904) Reports > Reprint Reports 

Substation Summary Payment, Fees, Inventory (5921/5922/5923) Reports > Reprint Reports 

Title Package Report (5911) Reports > Reprint Reports 

1
 Prints as a column in the report when apprehension data is available 

2
 
 
Now runs as one report; the Summary displays at the top while the transactions display in the sections 

that follow the Summary. 


